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[bookmark: _Toc510135604]Методические указания для обучающихся по освоению дисциплины 
Общие методические указания
Успешное усвоение курса предполагает активное, творческое участие студента на всех этапах ее освоения путем планомерной, повседневной работы. Студентам необходимо ознакомиться:
с содержанием рабочей программы дисциплины;
с целями и задачами дисциплины, ее связями с другими дисциплинами образовательной программы;
методическими разработками по данной дисциплине, имеющимися на сайтах библиотеки РГРТУ;
с графиком консультаций преподавателей кафедры.
К изучению дисциплины предъявляются следующие организационные требования:
обязательное посещение студентом всех видов контактных занятий;
качественная самостоятельная подготовка к практическим занятиям, активная работа на них;
активная, ритмичная самостоятельная аудиторная и внеаудиторная работа студента в соответствии с планом-графиком;
своевременная сдача преподавателю отчетных документов по контактным видам работ;
в случае наличия пропущенных студентом занятиям, необходимо получить консультацию по подготовке и оформлению отдельных видов заданий.
При подготовке к практическим занятиям студентам следует:
приносить с собой рекомендованную преподавателем материалы (конспекты лекций, литературу) к конкретному занятию;
до очередного практического занятия по конспектам лекций и рекомендованным литературным источникам проработать теоретический материал, соответствующей темы занятия;
задать преподавателю вопросы по материалу, вызвавшему затруднения в его понимании и освоении при решении задач, заданных для самостоятельного решения;
на занятии доводить каждую задачу до окончательного решения, демонстрировать понимание проведенных расчетов (анализов, ситуаций), в случае затруднений обращаться к преподавателю.
Студентам, пропустившим занятия (независимо от причин), рекомендуется обратиться к преподавателю в день консультаций и получить индивидуальное задание. 
Для выполнения практической работы обучающийся должен предварительно изучить необходимые темы теоретического курса и получить конкретные рекомендации от преподавателя о порядке и составе выполняемой работы.
По завершению изучения дисциплины сдается экзамен.
При подготовке к экзамену необходимо ориентироваться на конспекты лекций, рабочую программу дисциплины, учебную и рекомендуемую литературу. Основное в подготовке к сдаче экзамена – это проработка контрольных вопросов и систематизация теоретических знаний, подтверждение практическими примерами и выкладками.
Подготовка студента к промежуточной аттестации по дисциплине включает в себя три этапа: систематическая работа в течение семестра; непосредственная подготовка в дни, предшествующие экзамену по темам курса.
Возможные формы проведения экзамена: устный (в виде собеседования).
Экзамен проводится по вопросам, для успешной сдачи которого студенты должны понимать сущность вопроса, его смысл и уметь аргументировать структурные составляющие и подтверждать практическими примерами, что должно соответствовать компетенциям освоения дисциплины, указанным в рабочей программе.
Во время испытаний промежуточной аттестации студенты могут пользоваться рабочими программами учебных дисциплин, а также справочниками и прочими источниками информации, разрешенными преподавателем.
На экзамене нельзя пользоваться электронными средствами связи и материалами, неразрешенными преподавателем. Также не разрешается общение с другими студентами и несанкционированные перемещения по аудитории. Указанные нарушения являются основанием для удаления студента из аудитории с последующим проставлением в ведомости оценки «не удовлетворительно».
Методические указания к самостоятельной работе
Курс предусматривает аудиторную и внеаудиторную самостоятельную работу студентов, обозначенную рабочим планом дисциплины.
Для наиболее полного изучения дисциплины обеспечивается доступ каждого студента к библиотечным фондам и базам данных, по содержанию соответствующим полному перечню задач дисциплины, к методическим пособиям, фондам учебной литературы, а также наглядным пособиям.
Выполненные работы следует регулярно показывать педагогу. Качество работы проверяется преподавателем и должно учитываться при выставлении семестровой оценки по предмету.
[bookmark: _GoBack]Методические указания к разделам дисцпилины
Целью данной лабораторной работы является изучение основных элементов рабочего пространства, а также выполнение учебного проекта для изучения основ работы с Adobe Premiere.
[bookmark: _Toc339701389]1.1. Этапы создания цифрового видео
Как правило, этот технологический процесс создания цифрового видео состоит из следующих шагов:
1) съемка видеофильма;
2) перенос отснятого материала на жесткий диск;
3) монтаж;
4) добавление переходов и видеоэффектов;
5) создание титров;
6) создание аудиодорожки;
7) экспорт.
Программа Adobe Premier обеспечена полнофункциональным набором инструментальных средств стандартного цифрового редактирования видео:
редактирование звука; 
коррекция цвета; 
управление ключевыми кадрами;
поддержка аппаратных средств из широкого диапазона плат для захвата видео;
поддержка видео высокого разрешения.
Часть задач по созданию цифрового видео решается вне программы Adobe Premiere:
создание трехмерных эффектов (Adobe After Effects);
создание сложной анимации (Adobe Flash);
создание дисков DVD (Adobe Encore DVD);
работа с многоуровневой графикой и векторными иллюстрациями (Adobe Illustrator);
микширование, редактирование и обработка звуковых эффектов (Adobe Audition).
[bookmark: _Toc339701390]1.2. Рабочее пространство Adobe Premiere
Запустите программу Adobe Premiere. В появившемся диалоге щелкните мышью на кнопке Open Project. 
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В диалоге Open Project перейдите в каталог Lesson 01 и дважды щелкните мышью на файле Lesson 01.prproj. При этом откроется интерфейс пользователя. 
Основные элементы показаны на следующем рисунке.
[image: ]
Каждый элемент рабочего пространства расположен в собственной области – фрейме, который может содержать несколько панелей.
Рассмотрим основные панели Adobe Premier:
в панели Timeline выполняется основная часть задач по монтажу видео. С помощью панели Timeline создаются видео последовательности (Sequence), которые состоят из видео и аудио дорожек, на которых размещаются видеоклипы, статичные изображения, титры и т.д. 
панель Source Monitor используется для просмотра ресурсов проекта. 
[image: ]панель Program Monitor предназначена для просмотра выбранной видео последовательности. 
панель Project предоставляет доступ к функциям работы с ресурсами проекта: видеоклипами, аудио файлами, векторной и растровой графикой, титрами и последовательностями.
[image: ]панель Effects предоставляет доступ к эффектам и переходам. Эффекты объединены в папки Presets (Шаблоны), Audio Effects (Аудио эффекты), Audio Transitions (Аудио переходы), Video Effects (Видеоэффекты) Video Transitions (Видео переходы). 
панель Audio Mixer содержит элементы управления громкостью и балансом аудио треков и трека Master. 
[image: ]панель Tools представляет доступ к инструментам, каждый из которых выполняет определенную функцию редактирования.
панель Effect Controls предоставляет доступ к настройкам эффектов клипа. Для всех видеоклипов заданы два стандартных эффекта: Motion (Движение) и Opacity (Непрозрачность). 
панель Info предоставляет краткое описание любого ресурса, который выбран в панели Project.
панель History отображает историю процесса редактирования, а также позволяет отменять отдельные действия.
[bookmark: _Toc339701391]1.3. Настройка рабочей области
Интерфейс программных продуктов Adobe, относящихся к одной и той же версии, построен по одним и тем же  принципам:
интерфейс состоит из набора фреймов, каждый фрейм может содержать одну или несколько панелей;
при изменении размера фрейма другие фреймы также меняют свои размеры;
панель в пределах фрейма доступна с помощью вкладок;
все панели не закреплены строго в одном положении – их можно перемещать из одного фрейма в другой;
панель можно вывести из фрейма, сделав ее подвижным.
Для изменения размеров областей следует установить указатель мыши на вертикальную разделительную линию между фреймами, нажать и удерживать кнопку мыши, перетащить указатель влево или вправо. Указатель мыши становится на короткое время вертикальным разделителем-стрелкой между двумя областями.
Для перемещения окна следует щелкнуть мышью на верхнем левом углу окна (на маркере в виде пяти точек) и перетащите в нужную часть интерфейса. При перемещении панелей программа Adobe Premiere отображает зону, в которую будет помещена панель. Если это - прямоугольник, панель займет выбранный фрейм. Если это трапеция, панель будет занимать собственный фрейм. 
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Для создания плавающего окна (не связанного с фреймами) следует щелкнуть мышью на маркере перетаскивания и, удерживая клавишу (Сtrl), перетащить панель из области фрейма, затем отпустить кнопку мыши. 
[bookmark: _Toc339701392]1.4. Краткий обзор возможностей Adobe Premier
Задача данного урока состоит в том, чтобы понять, как происходит редактирование в Adobe Premier. В данной работе каждая из задач будет рассмотрена поверхностно. Все задачи содержат дополнительные возможности и функциональные особенности, более подробно описанные в следующих работах.
1. Запустите программу Adobe Premiere.
2. В появившемся диалоге Welcome (Приветствие), щелкните мышью на кнопке Open Project (Открыть проект), перейдите в папку Lesson 02 и откройте файл Lesson 2-1.prproj.
Этот проект открывается вместе с ресурсами (видеоклипами, аудио файлом и графическими файлами, созданными в программе Adobe Photoshop), загруженными в панель Project, и четырьмя последовательностями в панели Timeline.
[image: ] [image: ]

3. Чтобы открыть последовательность, щелкните мышью на файле Lesson 2 Finish, который находится среди файлов проекта. Эта совокупность клипов показывает, как будет выглядеть ваш законченный проект в конце данной работы.
[image: ]
4. Убедитесь, что курсор текущей позиции редактирования, выделенный на следующем рисунке, находится в начале этой последовательности. В противном случае нажмите клавишу (Home), чтобы переместить курсор текущей позиции редактирования в начало (также вы можете просто щелкнуть на нем мышью и перетащить в крайнюю левую позицию).
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Нажатие клавиши (End) перемещает курсор текущей позиции редактирования на окончание последнего клипа в последовательности. Нажимая клавиши (PgUp) или (PgDown), вы перемещаетесь назад или вперед по последовательности, сразу на один клип.
Если нажатие клавиши не вызывает никакого эффекта, значит панель Timeline сейчас не активна. Щелкните мышью на любом участке панели Timeline, чтобы сделать ее активной (вокруг любой активной области появляется оранжевая рамка), а затем нажмите нужную клавишу.
5. Нажмите клавишу (Пробел), чтобы запустить последовательность. Просмотрите видео в панели Program. Это ряд коротких видеоклипов с музыкальным фоном, который заканчивается графикой. Обратите внимание на наличие перехода Slide (Скольжение) между третьим и четвертым клипом, а последний клип становится неподвижным, а затем расплывчатым, как только текст и графика постепенно исчезают на фоне неподвижного клипа.
6. В панели Timeline щелкните мышью на вкладке Lesson 2 Start, чтобы открыть эту пустую последовательность.
7. Нажав и удерживая кнопку мыши на значке файла Video 2a, перетащите его из панели Project на дорожку Video 1 панели Timeline и выровняйте левый край этого клипа по левому краю (началу) дорожки. Отпустите кнопку мыши.
Также по мере перемещения клипа, рядом с левой стороной дорожки появляется вертикальная черная линия ниже курсора текущей позиции редактирования, показывая, что первый кадр клипа начнется с позиции, отмеченной курсором текущей позиции редактирования, в начале этой последовательности.
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8. Нажав и удерживая левую кнопку мыши на видеоклипе Video 2b в панели Project, перетащите его в панель Timeline сразу после клипа Video 2a на дорожку Video 1. Когда вертикальная черная линия появится в конце первого клипа, отпустите кнопку мыши.
Эта черная линия указывает, что первый кадр второго видеоклипа начнется немедленно после последнего кадра предыдущего клипа.
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9. Повторите вышеописанные шаги для оставшихся четырех видео клипов. Затем добавьте второй экземпляр последнего видеоклипа – Video 2f – в конец последовательности. Вы превратите повторяющийся клип в неподвижный кадр. Последовательность должна выглядеть так же, как изображено на следующем рисунке.
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10. Перетащите файл Audio 2.wav в начало дорожки Audio 1.
11. Щелкните мышью на любом участке панели Timeline, чтобы сделать ее активной (вокруг нее появится оранжевый контур). Нажмите клавишу (Home), затем нажмите (Пробел), чтобы просмотреть проект.
При запуске последовательности, которую вы только что сформировали:
второй и третий клипы идут не по порядку, 
фрагмент между двумя кадрами является неуклюжим, 
в конце пропущен графический файл, 
редактирование одного фрагмента является грубоватым. 
Второй и третий видеоклипы в последовательности расположены не по порядку. Есть простой способ перетащить клип Clip 3 в позицию перед клипом Clip 2, но для этого требуется специальная клавиша. Сначала мы это сделаем неправильно.
12. Нажав и удерживая левую кнопку мыши на третьем клипе, перетащите его на дорожке Video 1 так, чтобы его левый край совпадал с левым краем второго клипа. Отпустите кнопку мыши. В последовательности образовался промежуток, как на следующем рисунке.
Вы только что сделали редактирование с наложением. Третий клип перекрыл второй клип, а не поменялся с ним местами.
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13. Нажмите клавиши (Ctrl+Z) чтобы отменить это действие.
14. Также с помощью левой кнопки мыши перетащите третий клип в ту же самую позицию и, прежде чем отпустить кнопку мыши, нажмите сочетание клавиш (Ctrl+Alt). Теперь отпустите кнопку мыши.
Вы только что выполнили вставку «извлечь и переместить». Нажатие сочетания клавиш (Ctrl+Alt) привело к следующему. При удержании клавиши (Ctrl) заполнился промежуток, который вы создали, когда извлекли третий клип и переместили остальную часть клипов, чтобы выделить место. При удержании клавиши (Alt) звуковая дорожка «отцепилась» от функции вставки (функция вставки обычно передвигает клипы на видео- и звуковых дорожках), поэтому звуковой клип не смещался по дорожке вместе видеоклипами, которые расположены перед ним.
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15. Воспроизведите эту часть проекта. Вы увидите, что последовательность клипов стала более осмысленной: актер теперь останавливается, быстро читает, и затем вы видите кадр с актером крупным планом, разворачивающим письмо.
16. Перетащите курсор текущей позиции редактирования через пятый и шестой клипы. Обратите внимание, что дверь открывается дважды. Это - ошибка монтажа, и ее легко исправить.
17. Установите курсор в позицию редактирования между двумя клипами, используя клавиши (PgUp) или (PgDown).
Щелкните мышью на кнопке Trim (Обрезка) в нижнем правом углу панели Program, выделенной на следующем рисунке, или нажмите сочетание клавиш (Ctrl+T), чтобы открыть диалог Trim.
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18. Перемещайте указатель мыши в левом экране, пока указатель не превратится в закрывающую скобку (см. следующий рисунок).
19. Нажав и удерживая кнопку мыши, переместите указатель мыши влево до двери, слегка открытой перед лицом главного актера.
Значение параметра Out Shift (Свиг), синего цвета, который находится в нижней части экрана, должно быть равно приблизительно 
-00;00;00;10 (-10 кадров — часы; минуты; секунды; кадры). Вы урезали конец левого клипа на одну треть секунды.
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20. Перемещайте указатель мыши в правом экране, пока указатель не примет вид открывающейся квадратной скобки, и переместитесь в позицию, соответствующую размерам двери, чтобы значение временного кода Out Shift для правого экрана стало равно приблизительно +00;00;00;09 (9 кадрам).
Вы вырезали почти одну треть секунды с начала правого клипа.
21. Щелкните мышью на кнопке Play Edit (Воспроизвести отредактированный фрагмент) в области диалога Trim, чтобы проверить результат вашей работы.
22. Закройте диалог Trim.
23. Выберите инструмент Rate Stretch (Изменение скорости) в панели Tools (Инструменты).
24. Перетащите правый край последнего клипа, пока он не совпадет с конечной точкой аудиоклипа на нижней дорожке.
Инструмент Rate Stretch замедляет заключительный клип. Наша  цель - привести длительность клипа в соответствие с длиной оставшегося аудио фрагмента и затем превратить растянутый клип в неподвижный кадр.
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25. Переключитесь снова на инструмент выбора, щелкнув мышью на значке инструмента в панели Tools.
26. Щелкните правой кнопкой мыши на области растянутого клипа, чтобы открыть контекстное меню, и выберите пункт Frame Hold (Задержка кадра). При этом открывается диалог Frame Hold Options (Настройки задержки кадра).
27. Установите флажок Hold On (Удержать), выберите пункт Out Point (Конечная точка) из открывающегося списка и щелкните мышью на кнопке Ok.
При этом создается неподвижный кадр, который соответствует заключительному кадру предыдущего клипа (так как оба клипа имеют тот же самый заключительный кадр).
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Рассмотрите вашу последовательность. Клипы размещены в логическом порядке,  скачок при обрезке скольжения двери удален, и последовательность заканчивается удачно созданным неподвижным кадром. 
Добавим переход, чтобы устранить резкий скачок монтажа между третьим и четвертым клипами - ближним кадром с желтым обрывком бумаги и промежуточным кадром с актером, держащим этот обрывок.
В третьем клипе актер держит обрывок горизонтально над коробкой, а в четвертом клипе прямоугольный лист уже находится в вертикальном положении перед лицом актера. Вы должны поступить так же, как и в случае со скользящей дверью – применение видео перехода может сделать монтаж менее грубым.
28. Щелкните мышью на вкладке Effects (Эффекты), чтобы открыть эту панель.
29. Щелкните мышью на треугольнике рядом с папкой Video Transitions (Видео переходы), чтобы открыть ее.
30. Разверните папку Slide (Скольжение).
31. Перетащите переход Slide в позицию редактирования между клипами 3 и 4.
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32. Перемещайте переход над позицией редактирования. Появится небольшой значок перехода, и позиция редактирования становится выделенной. Установите переход в этой точке.
Если вы перетаскиваете переход немного влево или вправо от позиции редактирования, значок будет меняться, показывая, что переход заканчивается или начинается в позиции редактирования. Это не столь важно, но для наших целей попробуйте выровнять переход по центру на линии редактирования.
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Появится информационное сообщение «Недостаточно данных». Эти клипы не имеют никаких дополнительных начальных или заключительных кадров, необходимых для перехода. Но Adobe Premiere решает эту задачу, повторяя кадры клипов.
33. Щелкните мышью на кнопке ОК, чтобы закрыть информационное окно сообщения.
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32. Щелкните мышью на небольшом прямоугольнике перехода, который теперь постоянно находится над позицией редактирования между двумя клипами. При этом отображаются параметры перехода в панели Effect Controls (Управление эффектом).
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33. Переместите курсор текущей позиции редактирования через позицию редактирования в панели Timeline, чтобы предварительно просмотреть переход. Четвертый клип надвигается слева на третий. Но пусть клип надвигался снизу.
34. Щелкните мышью на небольшом треугольном маркере «С юга на север» внизу экрана предварительного просмотра перехода в верхней части панели Effect Controls, чтобы изменить направление перехода. Соответственно меняется экран предварительного просмотра.
35. Переместите курсор текущей позиции редактирования через позицию редактирования, чтобы предварительно просмотреть вашу работу.
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Теперь вы примените видеоэффект к неподвижному кадру. Вы будете использовать эффект Blur (Пятно), который был заранее настроен для этой работы.
36. Откройте панель Effects.
37. Щелкните мышью на маленьком треугольнике в верхнем правом углу панели Effects, чтобы открыть меню.
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38. Выберите пункт Import Preset (Импорт предварительной установки), перейдите в папку Lesson 2 и дважды щелкните мышью на файле Lesson 2 Gradual Blur.prfpset.
39. Раскройте папку с шаблонами, чтобы отобразить добавленный эффект Lesson 2 Gradual Blur.
40. Перетащите эффект Lesson 2 Gradual Blur на заключительный видеоклип вашей последовательности - неподвижный кадр.
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41. Установите курсор текущей позиции редактирования перед неподвижным кадром и воспроизведите последовательность.
При воспроизведении замедленного кадра через минуту кадр постепенно становится расплывчатым.
42. Щелкните мышью на значке в виде двойной угловой скобки Show/Hide Timeline View (Показать/Скрыть временную шкалу) (<<), чтобы открыть часть временной шкалы панели Effect Controls (Управление эффектом).


Эффект был настроен с использованием ключевых кадров (значки, имеющие форму ромба).
43. В панели Timeline щелкните мышью на вкладке Graphic 2 Start, чтобы открыть эту последовательность.
44. Перетащите курсор текущей позиции редактирования к отметке 2 секунды (вы можете видеть вывод точного времени в панели Program).
45. Щелкните мышью на клипе Layer 3 и перетащите целый клип, так чтобы его первый кадр совпал с линией курсора текущей позиции редактирования на 2-секундной отметке.
46. Переместите курсор текущей позиции редактирования на отметку 4 секунды и перетащите клип Layer 4 так, чтобы клип начинался на 4-секундной отметке.
Так как этот клип (и вся другая графика) по умолчанию имеет продолжительность 5 секунд, клип Layer 4 должен теперь закончиться на отметке 9 секунд.
Клип Layer 1 это просто черный фон.
47. Перетащите клипы Layer 2 и Layer 3 так, чтобы выровнять концы этих клипов с концом клипа Layer 4.
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Черная, вертикальная линия появится в конце клипа Layer 4 на отметке 9 секунд.
Следующим шагом будет добавление перехода Cross Dissolve (Взаимное растворение) к началу клипов Layer 2 и Layer 3, чтобы заставить их постепенно исчезать на экране один за другим.
47. В панели Effects, в группе Video Transition (Видео переходы), разверните папку Dissolve (Растворение) и с помощью левой кнопки мыши перетащите эффект Cross Dissolve (Взаимное растворение) к началу каждого клипа Layer 2 и Layer 3.
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Теперь применим другой шаблон к клипу Layer 4. В этом случае - эффект Motion (Движение), чтобы заставить вращаться на экране круглую эмблему.
48. Откройте панель Effects.
49. Откройте меню, щелкнув мышью на кнопке с небольшим треугольником в верхнем правом углу панели Effects.
50. Выберите пункт меню Import Preset, перейдите в папку Lesson 2 и дважды щелкните мышью на файле Lesson 2 Logo Motion.prfpset.
51. Раскройте папку Presets, чтобы обнаружить недавно добавленный переход Lesson 2 Logo Motion, и перетащите этот переход на клип Layer 4 на дорожке Video 4 вашей последовательности.
52. Щелкните мышью на вкладке Effect Controls, раскройте эффект Motion и откройте часть временной шкалы Timeline View (Просмотр временной шкалы), щелкнув двойной угловой скобкой в верхнем правом углу панели.
Обратите внимание на ключевые кадры. Три имеют значки в виде песочных часов, которые указывают на то, что к ним добавлены ключевые кадры Bezier (Безье) (вращающееся изображение замедляется, как только достигает полного размера).
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53. Воспроизведите эту последовательность. Сначала два графических клипа постепенно исчезнут один за другим, затем третий графический клип - изображение круглой эмблемы - будет увеличиваться и вращаться на месте. Последовательность должна воспроизводиться 9 секунд.
54. Щелкните мышью на вкладке Lesson 2 Start в панели Timeline, чтобы открыть последовательность.
55. Откройте панель Project, щелкнув мышью на вкладке.
56. Перетащите клип Graphic 2 Start последовательности из панели Project на дорожку Video 2 так, чтобы первый кадр клипа совпал с началом последнего клипа в последовательности (неподвижный кадр).
Несмотря на то, что эта последовательность является совокупностью четырех многослойных файлов, она представляет собой просто клип.
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57. Просмотрите эту часть последовательности Graphic 2 Start.
Обратите внимание, что графический файл скрывает замедленный кадр, расположенный дальше на шкале времени, на первые несколько секунд, затем кадр появляется ближе к концу воспроизведения. В чем причина? Черный фон - клип Layer 1 во вложенной последовательности воспроизводится в течение первых 5 секунд 9-секундного клипа.
Другая важная особенность вложенных последовательностей состоит в том, что их легко исправить. Вы просто возвращаетесь к первоначальной последовательности и делаете необходимые изменения. Эти изменения немедленно обнаружатся во вложенных версиях данной последовательности.
58. Щелкните на вкладке Graphic 2 Start в панели Timeline, чтобы открыть эту последовательность снова.
59. Щелкните на клипе Layer 1, чтобы выделить клип, и нажмите клавишу (Delete), чтобы удалить его.
60. Щелкните на вкладке Graphic 2 Start и воспроизведите последний фрагмент снова. Теперь неподвижный кадр возникает после полного воспроизведения вложенной последовательности.
61. Перетащите правый край вложенной последовательности влево (это выполняется немного дольше) до совпадения с концом замедленного кадра и аудио клипа.
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62. Перетащите видео переход Cross Dissolve из папки Transitions Dissolve (Переходы растворения) панели Effects в конец клипа вложенной последовательности Graphic 2 Start, и в конец клипа с замедленным кадром. В результате этих действий все клипы в конце воспроизведения постепенно станут черными.
Когда вы применяете переход Cross Dissolve к клипу вложенной последовательности, все три графических клипа в этой последовательности постепенно становятся черными. В этом состоит огромное преимущество вложенной последовательности. Вместо применения эффекта или перехода к каждому слою последовательности, вы можете применить их только однажды к вложенной версии этой последовательности.
63. Перетащите аудио переход Constant Power (Постоянная мощность) из папки Crossfade папки Audio Transitions панели Effects в конец клипа Audio 2.wav, чтобы звук барабана постепенно исчезал вместе с видео и графикой.
64. Нажмите клавишу (Home) и затем (Пробел), чтобы просмотреть ваш законченный проект. Это должно выглядеть и звучать точно также как в последовательности Lesson 2 Finish.
[bookmark: _Toc339701393]Контрольные вопросы
1) Этапы процесса создания цифрового видео.
2) Основные элементы интерфейса – панели и фреймы.
3) Назначение основных панелей: Timeline, Source, Project, Effects, Effect Controls.
4) В чем заключается преимущество функции Snap (Захват)?
5) В чем заключается основное различие между редактированием методом Overlay (Наложение) и редактированием методом Insert (Вставка)?
6) Назовите несколько комбинаций быстрых клавиш для перемещения в диалоге Timeline (Монтажный стол).
7) Как вы замещаете один переход другим?
8) В чем заключается преимущество работы с многослойной графикой программы Photoshop?
9) Как работает вложенная последовательность?
[bookmark: _Toc339701394]Задание к лабораторной работе
Настройте рабочую область Adobe Premier по своему усмотрению, сохраните настройки.
Выполните учебное задание, повторив действия в §1.4.
[bookmark: _Toc339701395]
2. экспорт
В программе Adobe Premiere существуют различные способы экспортирования видео:
запись проектов на видеопленку;
кодирование в файл;
запись на DVD-диск
запись только звука;
преобразование всего проекта или его фрагмента в файл одного из стандартных форматов;
экспорт отдельных кадров или последовательности кадров;
Adobe Media Encoder - программный продукт, позволяющий создавать проекты для размещения на web-страницах, использования в мультимедийных дисках, для создания видео в формате DVD, а также широкоэкранных фильмов с высоким разрешением.
Для выполнения экспорта на панели Timeline необходимо выделить последовательность (в противном случае команда меню Export будет недоступна).
Для экспорта выберите команду меню File > Export (Файл > Экспорт).
Программа Adobe Premier предлагает восемь вариантов экспорта видео:
Movie (Фильм) - создает видеофайл формата Windows AVI, Apple QuickTime, или последовательность кадров;
Frame (Кадр) - преобразовывает выбранный кадр в графический файл формата BMP, GIF, Targa или TIFF;
Audio (Звук) - создает аудиофайл одного из трех форматов: WAV, AVI или QuickTime;
Title (Титры) – экспорт титров, созданных в Adobe Premier.
Export to Таре (Экспорт на пленку) - переносит ваш проект на видеопленку;
Export to DVD (Экспорт на DVD) - записывает ваш проект на DVD-диск;
Export to EDL (Экспорт в EDL) - создает список монтажных решений EDL для дальнейшей обработки вашего проекта в киностудии;
Adobe Media Encoder – внешнее приложение, сохраняет проект или часть проекта в файл одного из форматов: MPEG, Windows Media, RealMedia или QuickTime. Воспользуйтесь этой командой для создания потокового видео, размещаемого в Интернете, или, как в случае с форматом MPEG, для записи на DVD-диск.
[bookmark: _Toc339701396]2.1. Экспорт отдельных кадров
Установите курсор текущей позиции редактирования на кадре, который вы хотите экспортировать.
Выберите команду меню File > Export > Frame (Файл > Экспорт > Кадр). На экране появится диалог Export Frame (Экспорт кадра). Каждый раз при экспорте в стандартные файлы, вам будет предложен следующий диалог. В нижней части диалога в группе Summary (Отчет) появится информация о выбранном формате файла.
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В открывающемся списке File Туре (Формат файла) выберите тип файла (у формата GIF есть функция Compile Settings (Настройки сборки). Кроме того, вы можете сбросить флажок Add to Project When Done (По окончании добавить в проект).
Чтобы закрыть диалог Export Frame Settings (Настройки экспорта кадра), нажмите кнопку ОК. Укажите путь на диске и имя файла и нажмите кнопку Save.
[bookmark: _Toc339701397]2.2. Экспорт видео
В Adobe Premiere существует возможность экспортировать отдельный клип, всю последовательность или ее фрагмент в аудио/видеофайл, или в файл, содержащий только звуковые/только видео дорожки, а также как последовательность кадров. Подобные последовательности кадров могут быть использованы в программах Adobe Photoshop или Adobe Illustrator для создания анимации или наложения графических объектов.
Чтобы экспортировать всю последовательность, сначала выделите ее в панели Timeline или Program.
В случае экспортирования фрагмента последовательности, отметьте начало и конец фрагмента, передвигая границы линейки рабочей области.
При экспорте клипа выберите необходимый клип в панели Source или Project, и щелкните на его изображении, чтобы сделать клип активным. Укажите группу кадров в клипе, который вы хотите экспортировать, установив для него точки входа и выхода (In/Out) в панели Source.
Выполните команду меню File > Export > Movie (Файл > Экспорт > Фильм).
Нажмите кнопку Settings (Настройки).
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По сравнению с экспортом одного кадра, при экспорте в фильм вам доступно больше настроек:
Параметр File Types (Тип файла) отвечает за выбор из шести форматов графических файлов, а также AVI и QuickTime. Формат Waveform предназначен для экспорта только звукового сигнала.
Параметр Range (Диапазон). Если вы выбрали клип для экспорта в панели Source или Project, у вас есть выбор: либо экспортировать весь клип, либо определенную его часть между точками входа и выхода. При экспорте последовательности, будет записана либо вся последовательность целиком, либо часть, ограниченная линейкой рабочей области;
Параметр Export Audio (Экспорт звука). Сброс этого флажка приведет к экспорту только видеодорожек;
Параметр Embedding Options (Настройки вложения). Определитесь, включать ли ссылку на проект в экспортированный файл. Ссылка позволяет открывать и редактировать исходный проект из другого проекта программы Adobe Premier, или иного приложения, поддерживающего средство Edit Original (Редактировать оригинал);
Кнопки Save и Load. Вы можете сохранить и позднее загрузить использованные настройки экспорта.
Выберите группу Video, чтобы отобразить элементы управления данной группы.
Вы можете выбрать значение параметра Compressor (Тип сжатия) (если выбранный вами тип файла подвергается сжатию), а также указать значения параметров Color Depth (Глубина цвета), Frame Size (Размер кадра), Quality (Качество) и Pixel Aspect Ratio (Соотношение размеров пиксела).
Чтобы увидеть наиболее полный список типов сжатия, выберите тип файла QuickTime, для которого доступно более 20 кодеков (алгоритмов сжатия/восстановления). 
У каждого механизма сжатия звука или видео есть свои особенности, позволяющие ему оптимально функционировать при определенных условиях. 
Щелкните на кнопке ОК, чтобы закрыть диалог Export Movie Settings (Настройки экспорта фильма). Укажите путь и имя файла, нажмите кнопку ОК или кнопку Cancel (Отмена).
[bookmark: _Toc339701398]2.3. Экспорт звука
Используя диалог Export Movie Settings (Настройки экспорта фильма), можно создавать файлы, содержащие лишь звуковые дорожки. Для этого необходимо сбросить флажок Export Video (Экспорт видео) в группе General (Основные) диалога Export Movie Settings (Настройки экспорта фильма). Однако лучше использовать для этих целей команду File > Export > Audio (Файл > Экспорт > Звук).
Выберите команду меню File > Export > Audio (Файл > Экспорт > Звук).
[image: ]
В диалоге Export Audio Settings (Настройки экспорта звука) вам будет предложено три формата аудиофайлов: WAV, AVI и QuickTime. Последние два формата в основном используются для аудио/видеофайлов, но они вполне применимы и для аудиофайлов.
Откройте группу Audio (Звук).
В этой группе устанавливается качество экспортируемого звука. У вас есть на выбор несколько различных типов сжатия аудиофайлов.
Если вы хотите создать файл объемного звука в режиме Sound Surround 5.1, выберите указанный формат в открывающемся списке Channels (Каналы) в группе Audio (Звук).
Файлы формата QuickTime не поддерживают функцию воспроизведения звука в формате 5.1. Щелкните на кнопке OK, чтобы закрыть диалог Export Audio Settings (Настройки экспорта звука).
Укажите путь и имя файла, нажмите кнопку OK или кнопку Cancel (Отмена).
[bookmark: _Toc339701399]2.4. Работа с Adobe Media Encoder
Приложение Adobe Media Encoder позволяет осуществлять кодирование в формат MPEG. Дополнительно к этому приложение дает возможность работы с потоковым видео форматов Macromedia Flash Video, Windows Media, RealMedia и QuickTime.
Для запуска приложения выберите команду меню File > Export > Adobe Media Encoder (Файл > Экспорт > Adobe Media Encoder).
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Окно программы разделено на две части: слева расположено окно предварительного просмотра, справа - элементы управления, настраивающие параметры экспорта. 
Для предварительного просмотра может быть выбрано либо ваше исходное, либо выводимое видеоизображение. На вкладке Source (Источник) отображается видеопоследовательность до того, как к ней были применены какие-либо экспортные настройки. Вкладка Output (Вывод) показывает, как ваше видео будет выглядеть после его экспорта.
Временная шкала позволяет перемещаться по видео вперед и назад. 
Используйте команду Deinterlace (Отменить чересстрочную развертку), когда видео в последовательности является чересстрочным, а вам необходимо экспортировать его для воспроизведения с прогрессивной разверткой.
При выборе настроек экспорта вы можете либо воспользоваться готовыми шаблонами, либо создать свои собственные настройки. С изменением настроек экспорта, соответствующим образом изменяется и изображение на вкладке Output (Вывод).
[bookmark: _Toc339701400]
2.4.1. Экспорт в формате Flash
[image: ]Формат Adobe Flash Video основан на технологии Flash, такое видео можно воспроизвести на любом компьютере, если на нем установлен проигрыватель, поддерживающий flash-анимацию.
Из открывающегося списка Format (Формат) группы элементов управления Export Settings (Настройки экспорта) выберите значение Adobe Flash Video. Из всех форматов кодирования видео у Adobe Flash Video меньше всего доступных настроек.
Щелкните мышью на вкладке Video (Видео), расположенной ниже группы элементов управления Export Settings (Настройки экспорта). Установите параметры для экспорта.
[bookmark: _Toc339701401]2.4.2. Экспорт в формате QuickTime
Формат QuickTime предлагает наибольшее количество контролируемых параметров, однако набор готовых шаблонов у него весьма органичен - по восемь для каждого из стандартов NTSC и PAL.
Перейдите на вкладку Video (Видео) и щелкните на открывающемся списке Video Codec (Видеокодеки). Обратите внимание, что как и в случае с экспортом в формате QuickTime, вам будут доступны более 20 различных кодеков. У некоторых из них есть дополнительные настройки.
Перейдите на вкладку Audio (Звук) и обратите внимание, что предложенный набор настроек похож на тот, который вы встречали при экспорте звуковых дорожек с помощью команды File > Export > Audio (Файл > Экспорт > Звук).
[bookmark: _Toc339701402]2.4.3. Экспорт в формате Real Media
Real Media - один из форматов с наименьшим количеством изменяемых настроек. 
Из открывающегося списка Format (Формат) группы элементов управления Export Settings (Настройки экспорта) выберите значение Real Media.
Перейдите на вкладку Audiences (Аудитория).
С помощью элементов управления этой вкладки вы можете изменить битовую скорость передачи данных и выбрать между кодированием в одну стадию или в две стадии. 
[image: ]Этот параметр доступен для форматов Real Media и Windows Media. При выборе кодирования в две стадии кодировщик сначала анализирует исходное видео и лишь затем преобразовывает его. Кодирование в таком случае занимает в два раза больше времени, но при условии использования одних и тех же настроек, видеоизображение, кодированное в две стадии, будет выглядеть лучше изображения, кодированного в одну.
[bookmark: _Toc339701403]2.4.4. Сжатие в формате MPEG
MPEG (Moving Picture Expert Group - Экспертная группа по кинематографии) - это название рабочего комитета, входящего в состав таких организаций, как ISO (International Standardization Organization - Международная организация по стандартизации) и IEC (International Electrotechnical Comission - Международная электротехническая комиссия).
Комитет MPEG отвечает за разработку стандартов для сжатия оцифрованного звука и видео. Группа был основана в 1988 году, и за это время создала несколько стандартов сжатия, включая:
MPEG-1 - основной стандарт для дисков Video CD и звука в формате МРЗ. Качество видео, сжатого с помощью MPEG-1, находится на уровне VHS-видео-кассет, качество звука отвечает уровню CD-дисков с общей скоростью передачи данных до 1,5 Мбит/сек. Разрешение подобного видео всего 352x240, что составляет примерно четверть от качества несжатого цифрового видео.
MPEG-2 - стандарт сжатия DVD и спутникового видео со скоростью передачи данных для видео стандартного разрешения 3-15 Мбит/сек. (7-9 Мбит/сек - общепринятый диапазон скоростей для DVD-фильмов высокого качества) и 15-30 Мбит/сек. для видео высокого разрешения. Помимо этого, стандарт MPEG-2 поддерживает многоканальный звук;
MPEG-4 - стандарт для обычной и мобильной сети.
Щелкните мышью на открывающемся списке Format (Формат) группы элементов управления Export Settings (Настройки экспорта) и обратите внимание на пять предложенных форматов MPEG:
MPEG1 - скорость передачи данных 1,7 Мбит/сек., аудио сжато с помощью MPEG-1;
MPEG1-VCD - скорость передачи данных 1,15 Мбит/сек., аудио сжато с помощью кодека MPEG-1;
MPEG2 - содержит набор установок для видео высокого разрешения и видео с чересстрочной разверткой;
MPEG2-DVD - предлагает наибольшее количество установок. Выберите ту, которая позволяет достичь наивысшего качества картинки, одновременно не превышая положенных 4,7 Гб доступного пространства DVD-диска. Чтобы найти наиболее подходящую комбинацию параметров, обратите внимание на значение Estimated File Size (Предполагаемый размер файла) внизу окна, которое обновляется каждый раз, когда вы меняете установки или значения параметров;
MPEG2-SVCD - может быть воспроизведен в большинстве DVD-проигрывателей. На диск уместится около 35 минут видео, сжатого с помощью MPEG-2. Скорость передачи данных при подобном сжатии низка и составляет 2 Мбит/сек.

Щелкните на треугольном значке напротив значения Advanced Settings (Расширенные настройки), чтобы открыть дополнительные настройки.
У всех форматов, за исключением Flash Video, существует набор расширенных настроек. Прокрутите вниз вкладку Video (Видео) и обратите внимание на значение Bitrate Encoding (Тип скорости кодирования):
[image: ]CBR (Constant bitrate - постоянная скорость передачи данных) - хорошо подходит для Интернет-приложений, так как скорость не варьируется.
VBR (Variable bitrate - переменная скорость передачи данных) - обычно качество картинки лучше, чем при постоянной скорости, так как скорость увеличивается при воспроизведении сцен с повышенной активностью персонажей. Здесь у вас есть выбор между кодированием в одну и в две стадии. Кодирование в две стадии занимает больше времени, но качество полученного изображения лучше. 
В зависимости от выбранного качества изображения и производительности вашего компьютера процесс экспорта может занять различное время.
[bookmark: _Toc339701404]Контрольные вопросы
1) Назовите основные различия между командами Export > Movie и Export > Adobe Media Encoder.
2) Опишите два способа создания файлов с объемным звуком 5.1.
3) Какие форматы для экспорта потокового видео предлагает программа Adobe Media Encoder?
4) В чем различия между форматами MPEG-1 и MPEG-2?
[bookmark: _Toc339701405]Задание к лабораторной работе
Для выполнения лабораторной работы используйте файл с цифровым видео, не сжатым кодеками (RawVideoData.avi). Используя Adobe Premier, экспортируйте видео файл c использованием следующих форматов и кодеков:
MPEG1, CBR;
MPEG1, VBR, 1Pass;
MPEG1, VBR, 2Pass;
MPEG2, Quanlity=5, CBR, Bitrate=10Mbps;
MPEG2, Quanlity=5, VBR, 1Pass;
MPEG2, Quanlity=5, VBR, 2Pass;
H.264, CBR, Bitrate=max;
Adobe Flash Video, Bitrate=2Mbps;
QuickTime, Video Codec=Apple Component Video YUV422;
QuickTime, Video Codec=Apple DV PAL;
QuickTime, Video Codec=Apple H.261;
QuickTime, Video Codec=Apple Motion JPEG A;
QuickTime, Video Codec=Apple плоский RBG;
QuickTime, Video Codec=H.263;
QuickTime, Video Codec=H.264;
RealMedia.


Заполните следующую таблицу:

	Формат
	Параметры

	
	Размер, Mб
	Ширина
	Высота
	Час-тота кадров
	Битрейт, КБит/сек
	Вос-приятие

	
	
	
	
	
	
	



Колонку «Восприятие» заполняйте по десятибалльной шкале согласно своей субъективной оценке, причем «1» соответствует самому низкому баллу восприятия, а «10» - самому высокому.
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3. управление ресурсами. Применение эффектов
Цель работы: изучить средства настройки параметров проекта, импорт ресурсов и средства управления данными в панели Project, изучить средства монтажа клипов, удаление и редактирование со сдвигом интервалов между клипами; изучить применение эффектов и переходов, средства их точной настройки.
[bookmark: _Toc339701407]3.1. Выбор установок проекта
Основное правило при выборе настроек проекта состоит в том, чтобы подобрать такие настройки, которые соответствуют вашему исходному материалу, а не окончательному варианту проекта. Даже если ваша цель состоит в том, чтобы создать видео с низким разрешением (например, для публикации в сети Интернет), произведите монтаж в полном качестве, а понижение качества осуществите при рендеринге итоговой версии проекта.
Программа Adobe Premiere содержит два диалога настройки параметров: диалог Project Settings (Параметры проекта) и диалог Preferences (Настройки).
[bookmark: _Toc339701408]3.1.1. Диалог Project Settings
[image: ]Настройки в диалоге Project Settings применяются к вашему текущему проекту. Перед созданием нового проекта необходимо выбрать его параметры. 
После запуска проекта основные параметры из диалога Project Settings изменять нельзя.
После запуска Adobe Premiere на экране появляется заставка, а затем – окно приветствия, содержащее список Recent Projects (Предыдущие проекты).
Для создания нового проекта следует нажать кнопку New Project (Новый Проект), чтобы открыть диалог NewProject. 
Закладка Custom Settings содержит четыре раздела: 
1) General (Общий). Данный раздел содержит настройки базовых параметров проекта: размер и частота кадров, соотношение сторон пиксела, развертка и т.д.
2) Capture (Захват). Раздел содержит настройки параметров видеозахвата.
3) Video Rendering (Просчет видео). Параметры для настройки предварительного просмотра.
4) Default Sequence (Последовательность по умолчанию). Параметры видеопоследовательности, задаваемой по умолчанию.
[image: ]Закладка Load Preset содержит список шаблонов - заранее заданных настроек проекта. 
Рассмотрим основные шаблоны:
HDV – настройки проекта для видео высокой четкости;
DV-24p – настройки проекта для использования с камерами, снимающими в формате 24p.
DV-NTSC – настройки проекта для видео стандартной четкости стандарта телевидения для стран Северной и Южной Америк и Японии;
DV-PAL - настройки проекта для видео стандартной четкости стандарта телевидения стран Европы, Австралии и России.
Выбор шаблона определяется форматом материалов, используемых в проекте.
[bookmark: _Toc339701409]3.1.2. Диалог Preferences
Диалог Preferences вызывается командой Edit > Preferences > General. Далее краткое описание разделов диалога:
General (Общий). Задает длительность аудио и видео переходов, продолжительность неподвижных изображений и режим отката для видеокамер во время процесса захвата.
Audio (Звук). Настройки для встроенного микшера.
Audio Hardware (Аппаратные средства аудио) - заданное по умолчанию аудио-устройство.
Audio Output Mapping (Отображение выходного звукового сигнала) определяет способ передачи звука от каждого звукового устройства программе Adobe Premiere.
Auto Save (Режим автосохранения) устанавливает частоту и количество автосохранений. 
Capture (Захват) содержит четыре основных параметра захвата видео.
Device control (Управление устройством) содержит установки параметров устройства видеозахвата.
Label Colors (Цвета ярлыков). Здесь вы можете изменить заданные по умолчанию на панели Project (Проект) цвета ярлыков, связанные с типом данных.
Label Defaults (Значения ярлыков по умолчанию). Здесь вы можете назначить определенные цвета ярлыков для различных типов данных;
Media (Данные). Используйте этот раздел, чтобы освободить папки кэша.
Scratch Disks (Диски для хранения ресурсов). Вы можете установить местоположение папок для семи различных типов данных, включая файлы видеозахвата и файлы предварительного просмотра.
Titler (Создатель титров). Здесь вы можете определить используемые видео шрифта и образцы стилей в секции Adobe Titler (Создатель титров Adobe).
Trim (Обрезка). Регулировка необходимого количества кадров и аудио фрагментов для подрезки в случае выбора настройки Large Trim Offset (Большое смещение при подрезке) в секции Trim (Обрезка).
User Interface (Пользовательский интерфейс). Настройка цветовой гаммы интерфейса.
[bookmark: _Toc339701410]3.2. Импорт ресурсов
Импорт файлов может осуществляться при помощи команды меню File > Import (Файл > Импорт) или двойным щелчком мыши на пустом пространстве панели Project.
Импортируйте из папки Lesson 03 два аудиоклипа, графический файл Adobe Illustrator, два фотоснимка и видео.
[image: ]
В панели Project отобразятся ссылки на загруженные ресурсы проекта. При этом ресурсы проекта могут находиться в разных каталогах. 
Для примера импортируйте из папки Lesson 02 файлы Audio 2.wav и Graphic 2.psd (аудио клип и файл многослойной графики, созданный в программе Adobe Photoshop) и щелкните мышью на кнопке Open.
[image: ]При импорте многослойной графики откроется диалог Import Layered File (Импорт многослойного файла).
При выборе значения Sequence (Последовательность) параметра Import As (Импортировать как), программа:
добавляет папку в панель Project со всеми слоями как отдельными клипами;
создает новую последовательность с каждым слоем на отдельной видеодорожке.
При выборе для параметра Import As значения Footage (Материал) все слои будут объединены в один графический элемент и импортированы.
Для любого элемента в панели Project доступно контекстное меню, содержащее пункт Properties (Свойства). При выполнении данной команды отобразиться диалоговое окно со свойствами выбранного материала.
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На панели Project отображаются следующие свойства импортированных материалов:
частота кадров (Frame Rate);
время начала, окончания и длительность исходного материала;
время точки входа, точки выхода и длительность клипа;
размер кадра и т.д.
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[bookmark: _Toc339701411]3.3. Управление данными в панели Project
[image: ]Панель Project - это средство обращения к данным и средство для организации ресурсов: видеоклипов, аудио файлов, файлов с растровой графикой, титры и последовательностей. 
Каждый из перечисленных ресурсов хранится в проекте в виде ссылки. Собственно файлы - видеоклипы и другие данные - остаются в своих исходных каталогах, поэтому следует быть внимательным при перемещении проекта в другой каталог.
Ресурсы в панели Project могут отображаться в виде списка или в виде иконок. Переключение осуществляется кнопками [image: ], расположенными в нижней части панели.
Для организации ресурсов проекта используются папки (bin), которые могут содержать любые элементы проекта. Для создания папки следует нажать на кнопку [image: ], операции копирования, перемещения, переименования и удаления – через контекстное меню ресурса.
Для чернового монтажа иногда бывает достаточно удобно создать отдельную папку в проекте, скопировать в нее обрабатываемые видеоклипы, включить отображение в виде иконок, после чего пробовать различные варианты последовательного расположения клипов. 
После того, как черновой вариант монтажа готов, видеоклипы можно автоматически перенести в видеопоследовательность.
[image: ]убедитесь, что курсор текущей позиции редактирования находится в начале панели Timeline;
выберите команду меню Edit > Select All, чтобы выделить все клипы;
щелкните мышью на кнопке Automate to Sequence (Автоматизировать в последовательность) в левом нижнем углу панели Project.
Ordering – настройка Sort Order (Порядок сортировки) размещает клипы в последовательности, соответствующей порядку сортировки. Настройка Selection Order (Порядок выделения) помещает клипы в порядке выбора, если  щелкнуть мышью на отдельных клипах, удерживая нажатой клавишу (Ctrl);
Method. Вариантами выбора являются настройки Insert (Вставка) и Overlay (Перекрытие). 
Clip Overlap – перекрытие клипов. Перекрытие предполагает, что помещается переход Cross Disolve между всеми клипами;
Apply Default Audio/Video Transition – применить аудио/видеопереходы по умолчанию;
Ignore Audio/Video – игнорировать аудио/видео.
[bookmark: _Toc339701412]3.4. Управление проектом
Управление проектом осуществляется при помощи меню Project, которое предоставляет ряд возможностей, позволяющих отслеживать проекты и повторно использовать имеющиеся видео ресурсы. 
Рассмотрим основные команды меню Project:
Project Settings (Параметры проекта) – диалоговое окно, позволяющее просматривать и изменять часть параметров проекта;
Link Media (Привязать медиафайлы) - команда связывает объекты, импортированные в проект, с фактическими файлами;
Make offline (Отключить медиафайлы) - разрывает связь между медиафайлом и его объектом в проекте;
Automate to Sequence (Автоматизировать в последовательность) - перемещает выбранные файлы в последовательность;
Import/Export Batch List (Импорт/Экспорт пакетного списка) - создает или импортирует список имен файлов;
Project Manager (Управление проектом) - создает версию вашего проекта, сохраняя только ресурсы, которые вы задействовали в последовательностях, или собирает проект в одном месте, помещая все его ресурсы в одну папку;
Remove Unused (Удалить неиспользуемые объекты) - быстрый и простой способ очистить проект от ссылок на неиспользуемые клипы.
Экспорт пакетного списка осуществляется командой меню Project > Export Batch List (Проект > Экспорт пакетного списка). В появившемся диалоге необходимо ввести имя файла, выбрать путь  и нажать кнопку Save (Сохранить).
В результате создастся файл с расширением CSV, который можно просмотреть с помощью программы Notepad. Файл будет содержать только имена файлов, покадровые коды и имена исходных видеозаписей (если таковые имеются). В пакетном списке хранятся лишь имена аудио и видео файлов, но не сами изображения или графика.
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Для импорта пакетного файла следует выполнить команду меню Project > Import Batch List (Проект > Импорт пакетного списка), в появившемся диалоговом окне выбрать нужный файл.
В результате в панель Project будет добавлена новая папка, в которой все файлы будут помечены как Offline (Не связан).
[image: ]Привязка файлов осуществляется при помощи команды меню Project > Link Media (Проект > Привязать медиафайлы) или через контекстное меню. В появившемся диалоге Attach Which Media (Медиафайлы для привязки) следует выбрать нужный файл для связывания. При выборе нескольких не связанных файлов диалог Attach Which Media появится несколько раз подряд для каждого выбранного файла. Обращайте внимание на имя файла в заголовке диалога, чтобы точно привязать его к медиафайлу-источнику.
[bookmark: _Toc339701413]3.5. Диалог Project Manager
Диалог Project Manager используется для того, чтобы создать отдельную папку, в которой будут храниться все ресурсы, использованные при создании последовательностей. Это хороший способ архивации, упрощающий впоследствии поиск необходимого проекта. Как только все элементы будут собраны в одном месте, исходные ресурсы могут быть удалены.
Вы можете сэкономить дисковое пространство, сохранив лишь использованные в проекте ресурсы и вырезав из них фрагменты, которые вы вставляли в последовательность.
После выполнения команды меню Project > Project Manager предлагаются на выбор два варианта дальнейших действий, каждое из которых имеет свой набор параметров:
Create New Trimmed Project (Создать новый обрезанный проект);
Collect Files and Copy to New Location (Собрать файлы и скопировать в новую папку).
В обрезанном проекте конечные файлы (или ссылки на файлы) относятся только к тем частям клипа, которые были задействованы в последовательности. Здесь у вас есть выбор следующих параметров:
Exclude Unused Clips (Исключить неиспользуемые клипы) - при создании обрезанного проекта это само собой разумеется;
Make Offline (Отменить связь с медиафайлами) - вместо того, чтобы хранить клипы в виде файлов, создайте список, содержащий информацию об этих файлах;
Include Handles (Включить запасные кадры) - как и при видеосъемке, включенный параметр позволяет оставлять несколько запасных кадров в начале и конце клипа для более гладких переходов и последующего редактирования;
Rename Media Files to Match Clip Names (переименовать медиафайлы, чтобы совпадали с именами клипов) - если вы изменили имена клипов на более «понятные», вы можете оставить эти имена в новом обрезанном проекте.
Выбор команды Collect Files and Copy to New Location приведет к тому, что все ресурсы текущего проекта будут сохранены в одной папке. Команда позволяет управлять следующими параметрами:
Include Previews Files (Включить файлы предварительного просмотра) - это файлы, созданные при визуализации эффектов. В последствие они позволят вам сэкономить время, однако занимают больше пространства на жестком диске;
Include Audio Conform Files (Включить файлы подгонки аудио) - подгонка аудио протекает параллельно с импортированием аудиофайлов в проект. Обычно в файлах подгонки нет необходимости.
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Кнопка Calculate (Вычислить), расположенная в нижней части диалога Project Manager, позволяет определить размер файлов текущего проекта и прогнозируемый объем его обрезанной версии. Используйте эту функцию, чтобы проверить разницу при включении таких параметров, как Make Offline, Include Previews Files, а также при выборе параметров Include Audio Conform Files или Include Handles.

[bookmark: _Toc339701414]3.6. Редактирование клипов в панели Source
Панель Source позволяет выполнить некоторые операции по редактированию клипа до его перемещения в панель Timeline. Чтобы отобразить клип в панели Source, нужно дважды щелкнуть мышью на имени файла в панели Project (или перетащить клип из панели  Project  на панель Source).


При просмотре клипов на панели Source они отображаются в исходном формате, с исходной частотой кадров, размером кадра, параметрами аудио и т.п. При добавлении клипа на панель Timeline, Adobe Premiere преобразовывает его в соответствии с настройками последовательности.
Элементы управления панели позволяют:
проигрывать клип, задавать точку входа (точку начала воспроизведения);
точку выхода клипа (точку окончания воспроизведения), 
выполнять операции вставки и перекрытия в последовательность.
[bookmark: OLE_LINK1]При нажатии на кнопку вставки выполнится операция редактирования Insert (Вставить). Новый клип будет установлен в точке, отмеченной курсором текущей позиции редактирования, а все последующие клипы будут сдвинуты вправо.
При нажатии на кнопку перекрытия выполнится операция редактирования Overlap (Вставить c перекрытием). Новый клип будет установлен в точке, отмеченной курсором текущей позиции редактирования с наложением на последующие клипы.
[bookmark: _Toc339701415]3.7. Редактирование клипов на панели Timeline
При помощи панели Timeline можно добавлять клипы в последовательности, выполнять дополнительное редактирование клипов,  добавлять эффекты и переходы, работать с титрами.
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Несколько замечаний о панели Timeline:
на панели Timeline осуществляется редактирование последовательностей;
одновременно можно открыть несколько последовательностей;
последовательность может содержать до 99 видео дорожек;
последовательность может содержать до 99 аудио дорожек формата моно, стерео и 5.1;
каждая дорожка содержит собственные элементы управления;
горизонтальная ось на панели Timeline – ось времени, идущая слева направо.
панель Program отображает содержимое текущего кадра активной (выделенной) последовательности;
при помощи панели инструментов Tools над дорожками и клипами выполняются операции редактирования.
Последовательность – это контейнер, содержащий набор клипов, иногда вместе с дополнительными видео слоями, специальными эффектами и титрами, а также аудио. Количество последовательностей в проекте не ограничено.
Последовательность создается с использованием средств панели Project. 
Для открытия последовательности на панели Timeline необходимо дважды щелкнуть по ней на панели Project или выполнить команду Open in Timeline из контекстного меню последовательности на панели Project.
В самом простом случае, последовательность будет содержать только одну видео дорожку, на которой будут размещаться клипы, слева направо, в порядки их проигрывания. Последовательность может содержать дополнительные видео дорожки, в результате получается многослойная видео композиция; к этим видео слоям могут применяться эффекты смешивания (bending effects) и другие спецэффекты. Чем выше видео дорожка, тем «ближе» она к зрителю, - верхние видео дорожки скрывают нижние. 
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Последовательность может содержать одну или несколько аудио дорожек, которые при воспроизведении проигрываются одновременно. На отдельные дорожки бывает удобно размещать запись голоса, фоновую музыка, спецэффекты и т.п.
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Рассмотрим назначение инструментов панели Tools.
Selection (Выбор) - многоцелевой, универсальный инструмент; используется, чтобы перетащить, поместить, выбрать и обрезать клипы;
Track Select (Выбор дорожки) - инструмент дает  возможность выделить все клипы справа от позиции, которая будет указана. Удерживая клавишу (Shift), можно выделять несколько дорожек;
Ripple Edit (Редактирование со сдвигом). Инструмент обрезает клипы и сдвигает последующие клипы на дорожке на величину, равную вырезанному участку;
Rolling Edit (Редактирование без сдвига). Операция обрезает смежные клипы в точках выхода и входа одновременно на одно и то же количество кадров. Этот инструмент перемещает позицию редактирования между клипами, сохраняя позиции других клипов во времени и сохраняя общую продолжительность последовательности;
Rate Stretch (Изменение скорости). Инструмент позволяет растянуть или сократить клип, замедляя или ускоряя действие в клипе.
Razor (Лезвие). Инструмент разрезает клип или клипы на две части;
Slip (Сдвиг). Инструментом можно изменить начальные и конечные кадры клипа, не изменяя общей продолжительности или не затрагивая смежные клипы;
Slide (Скольжение). Редактирование сдвигает клип во времени, в то время как смежные зажимы подстраиваются, чтобы компенсировать перемещение. Когда клип перетаскивается влево или вправо с помощью инструмента Slide, точка выхода предыдущего клипа и точка входа следующего клипа перемещаются на то число кадров, на какое был перемещен клип. Общая продолжительность остается неизменной.
Pen (Перо). Инструмент используется, чтобы добавлять, выбирать, передвигать, удалять или корректировать ключевые кадры на панели Effect Controls (Управления эффектом) и для корректировки кривых в панелях Titler (Создатель титров) и Effect Controls.
Hand (Рука). Инструмент работает так же, как перемещение полосы прокрутки в нижней части панели Timeline;
Zoom (Изменение масштаба). Эта функция работает подобно кнопкам Zoom In (Увеличить) и Zoom Out (Уменьшить) в левом нижнем углу панели Timeline (Монтажный стол) и панели Viewing Area Bar (Панель области просмотра) в верхней части последовательности выше линейки Time Ruler (Шкала времени).

Для выделения отдельного клипа необходимо выбрать инструмент Selection и щелкнуть на клипе мышью. Если необходимо выделить дополнительные клипы, следует зажать клавишу (Shift) и щелкнуть на них.
Часто клип содержит связанные части: аудио и видео. При простом выделении клипа будут выделены обе части одновременно. Для того, чтобы разорвать связь между видео и аудио частями одного клипа, при выделении необходимо нажать клавишу (Alt).

Для выполнения обрезки достаточно перетаскивать границу клипа в панели Timeline по помощи мыши.
Для увеличения точности данного действия можно:
увеличивать масштаб времени в панели Timeline;
установить маркер времени в нужную позицию, а затем перетаскивать границу клипа (при включенной опции привязки [image: ]).
Обрезка двух клипов оставляет пробелы в последовательности. Удалить пробелы можно используя функцию Ripple Delete (Удаление со сдвигом). Для этого нужно щелкнуть правой кнопкой мыши на пустом интервале и выбрать команду контекстного меню Ripple Delete. Функция удаляет интервал, сдвигая весь материал после пустого интервала влево.
Чтобы избежать пустых промежутков при редактировании, можно воспользоваться инструментом Ripple Edit (Редактирование со сдвигом). Клипы при использовании данного инструмента сдвигаются влево, чтобы заполнить интервалы, или сдвигаются вправо, приспосабливаясь к удлинению клипа.

Существуют два способа переместить клип из текущего местоположения в панели Timeline:
Lift (Вырезка). Оставляет пропуск там, где был клип. Осуществляется обычным перетаскиванием клипа при помощи мыши.
Extract (Извлечение) – работает подобно функции Ripple Edit, другие клипы перемещаются для заполнения интервалов. Для этой операции при перетаскивании клипа следует удерживать нажатой клавишу (Ctrl).
[bookmark: _Toc339701416]3.8. Корректировка клипов в панели Trim
Панель Trim (Обрезка) является средством, позволяющим точно выполнять операцию редактирования клипов. Для работы с панелью установите курсор между двумя клипами на панели Timeline и отобразите панель Trim (при помощи горячей клавиши (T), либо командой Window > Trim Monitor, либо нажав на кнопку [image: ] на панели Program Monitor).
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При перемещении мыши над мониторами указатель мыши принимает форму курсора инструмента Rolling Edit (между клипами) или Ripple Edit (над левым и над правым клипом, далеко от середины). Перемещение указателя мыши при зажатой левой кнопке приведет к применению соответствующего инструмента. На мониторах будет виден результат редактирования.
[image: ]Под мониторами отображается значение:
длительности первого клипа;
время точки выхода первого клипа;
время точки редактирования;
время точки входа во второй клип;
длительность второго клипа.
Далее отображаются линейки времени, также предоставляющие возможность задать точку выхода первого клипа и точку входа второго.
Еще ниже отображается время сдвига точки выхода, время сдвига точки входа, а также кнопки, позволяющие изменить точки входа/выхода на 1 и на 5 кадров.
[bookmark: _Toc339701417]3.9. Применение переходов
Adobe Premiere содержит ряд эффектов, предназначенных для замены обычного монтажного стыка кадров. Данный вид эффектов называются переходами. Для применения перехода достаточно перетащить его мышью из панели Effects на нужный клип (или между клипами) на панель Timeline. Для отображения панели Effects следует выполнить команду меню Windows > Workspace > Effects.
Для работы с переходами необходимо рассмотреть два понятия: точки редактирования и обработчики. 
Точка редактирования – это момент времени на панели Timeline, где заканчивается один клип и начинается другой. Adobe Premiere отображает точку редактирования в виде вертикальной линии между клипами.

Если для клипов не задавались точки входа/выхода, то в правом и левом верхних углах будут отображаться небольшие треугольники (выделенные на следующем рисунке).
Треугольники говорят о том, что клипы находятся в состоянии первоначальной длительности. Для гладкой работы переходов понадобятся обработчики - некоторые не использующиеся начальные и конечные кадры, которые появляются путем задания точки входа и точки выхода, не совпадающей с началом и окончанием ресурса.
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[image: ]Откройте панель Effects, в ней - папку Video > Transitions > Dissolve. Перетащите мышью переход Cross Dissolve к месту редактирования между вашими двумя клипами на последовательности. Удерживая кнопку мыши, переместите указатель мыши влево и вправо, и обратить внимание, как изменяется вид указателя мыши и прямоугольник выделения на клипах. Можно разместить переход так, чтобы он заканчивался в позиции редактирования, был отцентрирован на позиции редактирования или начинался с этой позиции.
[image: ]По умолчанию длительность перехода составляет 1 секунду. Задать длительность по умолчанию можно при помощи параметра Default Transition Duration (Заданная по умолчанию продолжительность перехода) в диалоге Edit > Preferences > General.
[image: ]Длительность перехода можно изменять на панели Timeline путем перетаскивания правого края маркера перехода в последовательности. 
Для поиска эффектов и переходов в панели Effects нужно ввести начальные символы имени перехода в поле ввода Contain и тогда отобразятся только папки, содержащие в себе требуемые переходы.

Когда к последовательности добавляется переход (или видеоэффект), над этим переходом появляется короткая красная горизонтальная линия. Эта красная линия означает, что данная часть последовательности должна быть просчитана прежде, чем можно будет вывести проект в файл.
Просчет происходит автоматически, когда экспортируется проект, можно выполнить просчет выделенных частей вашей последовательности, чтобы переходы воспроизводились более гладко. Для этого нужно нажать на кнопку (Enter). 
Программа Adobe Premiere создаст видеоклипы в папке Preview Files (Файлы предварительного просмотра) и заменит красную линию на зеленую.
[bookmark: _Toc339701418]3.10. Изменение параметров эффекта на панели Effect Controls
Режим редактирования А/В панели Effect Controls (Управление эффектом) разбивает отдельную видеодорожку на две субдорожки. То, что обычно было бы двумя последовательными и непрерывными клипами на единственной дорожке, теперь отображается как отдельные клипы на раздельных субдорожках. 
Режим A/B позволяет применить управлять начальными и заключительными кадрами, изменять длительность и другие свойства перехода.

Рассмотрим работу с панелью Effect Controls на примере перехода Cross Disolve. Щелкните мышью на прямоугольнике перехода в верхнем левом углу клипа в последовательности, чтобы отобразить параметры в панели Effect Controls.
Установка флажок Show Actual Sources отображает вместо квадратов "А" и "B" два небольших экрана предварительного просмотра. Длительность эффекта можно задать в поле Duration, выравнивание относительно точки редактирования – в поле Alignment.
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Установите указатель мыши над белой строкой редактирования в центре прямоугольника перехода (выделено на следующем рисунке).
Это позиция редактирования между двумя клипами, а указатель мыши, который здесь появляется, является указателем инструмента Rolling Edit. Перетащите указатель инструмента Rolling Edit влево и вправо. Обратите внимание, как проявляются изменение выходной точки левого клипа и изменение входной точки правого клипа в панели Program.
Используйте инструмент Slide (Скольжение), чтобы перетащить прямоугольник перехода влево и вправо. Это действие изменяет начальную и конечную точки перехода, не изменяя полной длительности (заданная по умолчанию продолжительность: 1 секунда). Новые начальные и конечные точки отображаются в панели Program. Но в отличие от инструмента Rolling Edit, перемещение прямоугольника перехода не изменяет позицию редактирования между двумя клипами.
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Adobe Premiere позволяет работать с многоканальными звуковыми файлами формата моно, стерео 2.0, стерео 5.1. На следующем рисунке представлен вид панели Source для указанных видов аудио файлов. 
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Когда звуковой клип перетаскивается в последовательность, на которой нет подходящей к типу клипа дорожки, программа автоматически создает новую дорожку, которая подходит данному типу клипа.
Можно узнать тип звуковой дорожки по значку: моно - один динамик, стерео - два динамика, 5.1 - цифры 5.1. 
Главная звуковая дорожка по умолчанию – стерео 2.0. Можно изменить стандартные установки, выбрав команду меню Project > Project Settings > Default Sequence.

[image: ]Для того, чтобы отредактировать громкость клипа в панели Timeline, не используя эффект Volume (Громкость) панели Effect Controls: 
нажмите кнопку Show Keyframes (Показать ключевые кадры) и выберите команду Show Clip Keyframes (Показать ключевые кадры клипа);
установите указатель мыши над графиком Volume Level Graph (График уровня громкости) - тонкая желтая горизонтальная линия между левым и правым каналами, затем перемещайте желтую линию вверх и вниз.
Показатель уровня громкости в децибелах (dB) представляет относительное изменение уровня громкости. Нажав и удерживая клавишу (Ctrl), щелкните на линии Volume Level Graph (График уровня громкости) в четырех местах, расположенных на равном расстоянии друг от друга вдоль желтой линии. На линии громкости появятся четыре ключевых кадра.
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Перетащите ключевые кадры для настройки громкости звука. Настройка ключевых кадров в панели Timeline - это процесс легкий и быстрый, но для точной настройки параметров ключевых кадров нужно будет использовать эффект Volume.
Откройте панель Effect Controls. Щелкните мышью на треугольных кнопках меню эффекта Volume и увеличьте размер панели Effect Controls, чтобы шкала времени была в поле зрения.
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Рассмотрим параметры эффекта:
Bypass (Обойти). Если нажать кнопку Bypass в любой части клипа, клип возвращается на исходный уровень громкости.
Level (Уровень). Единственный настраиваемый параметр для громкости.
Keyframes (Ключевые кадры). Все ключевые кадры и методы ключевой интерполяции, которые были применены к клипу в панели Timeline, отображаются на временной линии панели Effect Controls.

Для плавного увеличения громкости звука в начале клипа (или для плавного уменьшения в конце), можно использовать два аудио перехода: Constant Power или Constant Gain.
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Различие между переходами – в форме огибающей кривой изменения громкости, при этом Constant Power создает более плавный переход.

Папка Audio Effects панели Effect содержит ряд эффектов для обработки аудио: эквалайзеры, компрессоры, инструменты шумоподавления и модуляции, ревербераторы. Их назначение рассмотрено в разделе курса по обработке звука, а применение данных эффектов ничем не отличается от применения эффектов обработки видео.

Можно изменить громкость на графике громкости каждого клипа в панели Timeline или использовать эффект Volume на панели Effect Controls, но иногда проще настроить уровни громкости (и другие свойства) для множества дорожек, применяя аудиомикшер.
Аудиомикшер открывается при помощи команды меню Window > Workspace > Audio.
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При помощи панели Audio Mixer можно:
редактировать имена дорожек;
настраивать громкость и панораму каждой дорожки;
накладывать эффекты на дорожки;
применять автоматизацию для параметров эффектов.
Ниже приведено краткое описание каждого из доступных режимов автоматизации:
Off (Выключено). Игнорируются любые внесенные изменения параметров эффектов. 
Read (Чтение). Сохраненные данные о громкости и панораме/балансе считываются и применяются для управления уровнем звука во время воспроизведения дорожки.
Write (Запись). Записывает сделанные изменения, когда воспроизводится последовательность.
Latch (Фиксация). Идентичен режиму Write (Запись), за исключением того, что режим автоматического отслеживания изменений не включается до тех пор, пока не изменяется какой-либо параметр.
Touch (Касание). Идентичен режиму Latch (Фиксация) за исключением того, что после прекращения регулировки значение этого параметра возвращается к настройке, которая была сохранена до текущих изменений параметра.
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1) Основные настройки параметров проекта в диалоге Project Settings.
2) Выбор шаблона проекта
3) Импорт ресурсов в проект: аудио, видео, графические файлы.
4) Управление данными в панели Project.
5) В чем разница между экспортом видео в виде пакетного списка, экспортом в формате AAF и созданием обрезанного проекта с помощью средства Project Manager?
6) Назовите две основные функции средства Project Manager.
7) Опишите операции редактирования в панели Source.
8) Опишите операции редактирования в панели Trim.
9) Инструменты панели Tools.
10) Способы вставки и перемещения клипа в панель Timeline.
11) Как изменить длительность перехода, заданную по умолчанию?
12) Как найти переход по имени?
13) Как заменить один переход другим?
14) Перечислите три способа изменить продолжительность перехода.
15) Управление параметрами перехода на панели Effect Controls.
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1. Целью данной лабораторной работы является создание рекламного видеоролика, посвященному одному из учебных занятий кафедры ИТГД РГРТУ. 
2. Исходные материалы (видео в формате HTTV 1080i, 16:9) расположены в архиве каталоге PROJECT 03. Архив содержит видеозапись занятий по дисциплинам:
рисунок;
живопись;
пластическая анатомия;
двухмерная анимация;
работа с видео оборудованием;
фотографика;
трехмерная анимация.

Для выполнения работы нужно выбрать видеозаписи одной дисциплины в соответствие с вариантом задания. Каждый из вариантов содержит только фрагменты видео, аудио трек для данной работы необходимо выбрать самостоятельно. 
3. Результатом выполнения работы должен являться рекламный видеоролик длительностью 60 секунд, цель ролика – динамичное представление проведения учебного занятия (в стиле «трейлеров» или рекламы).
4. Этапы выполнения работы:
просмотреть видеоматериал;
используйте работу с папками на панели Project для формирования чернового варианта монтажа ролика;
примените инструменты редактирования панели Source, инструмент Trim и другие возможности панели Tools;
изучите, и при необходимости, настройте горячие клавиши по своему усмотрению для наиболее часто используемых действий;
добавьте и настройте эффекты и видеопереходы; используйте режим А/В и панель Effects Control для точной настройки времени;
подберите звуковой трек для видео ролика; настройте его звучание, применяя средства работы с огибающими громкости, эффекты и средства панели Audio Mixer;
выполните экспорт созданного видеоролика с использованием следующих кодеков и форматов: a) DV AVI; б) MPEG-2; 
в) Apple QuickTime MPEG-4.
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4. применение эффектов
Цель работы: изучить различные видео эффекты и средства настройки анимации – работы с ключевыми кадрами.
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[image: ]Для изменения скорости клипа следует выполнить команду контекстного меню клипа Speed/Duration (Скорость/Продолжительность) (или команду меню Clip > Speed/Duration). Это действие открывает диалог Clip Speed/Duration, содержащее следующие настройки:
Speed (Скорость), как процентное отношение. Удвоенная скорость – это 200%, а половина скорости - 50%.
Кнопка Link/Unlink (Связать/Разделить). Если выбрана настройка «связано»(настройка по умолчанию), изменение скорости соответственно изменяет длительность. Если выбрана настройка «разделено», длительность остается той же.
Reverse Speed (Обратная скорость) воспроизводит видео- и аудиоклипы в обратном направлении с любой скоростью, которую вы устанавливаете.
Maintain Audio Pitch (Сохранение тональности аудио) - сохранение тональности аудио означает, что аудио изменяет скорость, но сохраняет первоначальную тональность.
Duration (Длительность). Вместо процентного отношения вы можете задать точное время воспроизведения клипа.
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Видеоэффекты позволяют:
создать визуальный стиль;
исправить технические проблемы клипов;
изменить экспозицию или цвет изображения;
анимировать клип;
корректировать размер и положение кадра.
Для добавления видеоэффектов необходимо перетащить мышью и отпустить на клип (или вложенную последовательность) эффект из панели Effects.
Все параметры видеоэффекта доступны в панели Effect Controls. Ключевые кадры могут быть заданы независимо для каждого параметра. Для регулировки скорости изменения параметров используются кривые Безье.
Практически все параметры для всех видеоэффектов зависимы от ключевых кадров. То есть вы можете изменить поведение эффекта с течением времени. Например, вы можете заставить эффект постепенно выключиться, изменить цвет, деформировать изображение подобно кривому зеркалу или увеличить длину тени объекта.

Рассмотрим работу с ключевыми кадрами на примере. Для любого клипа на текущей последовательности добавьте эффект Fast Blur In (Быстрое размытие), открыв меню Presets > Blurs (Шаблоны > Размытия) в панели Effect Controls. Воспроизведите клип, чтобы увидеть, как работает этот шаблон. Клип начинается при максимальном значении размытия и увеличивает резкость на секундной отметке.


Перетащите мышью второй ключевой кадр эффекта вправо и воспроизведите клип снова. Теперь интервал между размытым и сфокусированным изображением увеличился. Ключевые кадры не являются постоянно закрепленными. Вы можете изменить их положение, не изменяя установленных в этих точках свойств эффекта.
Удалите эффект Fast Blur и примените эффект Replicate (Копирование) (папка Stylize). Выполните следующие действия:
раскройте список свойств эффекта.
установите курсор текущей позиции редактирования на начало клипа;
щелкните мышью на кнопке с изображением секундомера Toggle Animation (Включить/выключить анимацию), выделенной на следующем рисунке. 
Вышеуказанная операция делает следующее:
включает режим ключевых кадров;
добавляет ключевой кадр в точку, отмеченную курсором текущей позиции редактирования, и устанавливает в этой точке начальное значение эффекта Replicate, равное двум (сетка копируемых клипов 2x2);
показывает две тонких черных линии на монтажном столе панели Effect Controls: Value Graph (График значений) и Velocity Graph (График скорости).


Установите курсор текущей позиции редактирования приблизительно на отметку 1 секунда.
Установите значение параметра Count (Счетчик) эффекта Replicate равным 9. Это действие автоматически добавляет следующий ключевой кадр в этой точке, поскольку изменение параметра эффекта в позиции, не содержащей ключевой кадр, автоматически добавляет новый ключевой кадр,
Установите курсор текущей позиции редактирования приблизительно на отметку, соответствующую третьей секунде.
Щелкните мышью на кнопке Add/Remove Keyframe (Добавить/Удалить ключевой кадр), расположенной между двумя навигационными кнопками для ключевых кадров.
В результате этого действия добавляется ключевой кадр с тем же самым значением, что и предыдущий ключевой кадр. Таким образом, эффект не будет изменяться от позиции 1 секунда до позиции 3 секунды.
Переместитесь в конец клипа, нажав клавишу (End), а затем нажмите клавишу (Left), чтобы отобразить последний кадр клипа. 
Измените значение Count (Счетчик) на 16.
Воспроизведите клип и обратите внимание, что эффект, построенный на сетке 9x9, держится в течение двух секунд, а затем количество ячеек увеличивается до 16x16 в конце воспроизведения.

Рассмотрим действия для изменения значений параметров эффектов, заданных для ключевых кадров.
Щелкните мышью на кнопке Go to Previous Keyframe (Перейти в предыдущий ключевой кадр) дважды, чтобы переместиться ко второму ключевому кадру.
Установите ползунковым регулятором Count значение 2. Это первый простой способ изменить значение ключевого кадра.
Щелкните мышью на кнопке Go to Next Keyframe (Перейти к следующему ключевому кадру), чтобы переместиться в третий или четвертый ключевой кадр.
Установите указатель мыши на маркере значения на графике для этого ключевого кадра (выделенном на следующем рисунке). Как только указатель мыши превратится в изображение крошечной стрелки (инструмент Pen), перетащите маркер настолько высоко, чтобы изменить значение на 16. Это другой способ изменить значение ключевого кадра.
Вы можете перетаскивать маркер на графике значений только вверх или вниз. Вы не сможете двигаться влево или вправо, чтобы по неосторожности не изменить время позиции ключевого кадра в пределах клипа.
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Если вы планируете многократно использовать эффект с ключевыми кадрами, сохраните его в качестве шаблона. 
Чтобы создать шаблон эффекта, установите ключевые кадры, параметры и элементы управления интерполяцией, щелкните мышью на названии эффекта в панели Effect Controls и откройте меню панели. В появившемся меню выберите команду Save Preset (Сохранить шаблон), присвойте шаблону эффекта имя, обратите внимание на способ применения эффекта - применить по всей длине клипа или закрепить в точке входа In или выхода Out клипа, затем щелкните мышью на кнопке ОК. 
Созданный таким образом шаблон эффекта появится в папке Presets (Шаблоны).
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Связанные с клипом видеоэффекты (не фиксированные) применяются в том порядке, в котором расположены снизу вверх в панели Effect Controls.
Например, если вы применяете эффект Tint (Оттенок), а затем применяется эффект Black & White (Черно-белый), клип станет черно-белым. Эффект Black & White перекрывает эффект Tint, так как появляется позже эффекта Tint в списке эффектов панели Effect Controls. 
Если вы применяете эффект Black & White раньше, чем Tint, оттенок клипа будет таким, какой вы выбираете в параметрах эффекта Tint.
Фиксированные эффекты Opacity (Непрозрачность) и Motion (Движение) всегда являются заключительными эффектами, даже в том случае, если вы использовали заранее созданный эффект Motion и применили его первым. 
Если вы хотите, чтобы движение применялось в другом порядке, используйте эффекты движения, привязанные к клипу, как, например, Camera View (Вид камеры), Transform (Преобразование) или Basic 3D (Основной 3D). 
Чтобы изменить порядок эффектов, вы можете перетащить название эффекта вверх или вниз в панели Effect Controls.
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Интерполяция ключевого кадра изменяет поведение свойств эффекта при приближении или отдалении от ключевого кадра. Заданное по умолчанию поведение, которое вы видели до сих пор, является линейно зависимым - так как скорость между ключевыми кадрами постоянная. Как правило, для точной передачи чувств и настроения сюжета требуется постепенное ускорение или замедление изменения свойств эффекта.
Программа Adobe Premiere предлагает два способа управлять этими изменениями:
интерполяция ключевого кадра; 
инструмент Velocity Graph (График скорости).
Рассмотрим применение двух данных способов на примере.
1. Создайте пустую последовательность. Загрузите в нее клип из файла Graphic 9.psd.
2. Увеличьте длительность графического клипа со стрелкой в панели Timeline приблизительно до отметки 10 секунд.
3. Увеличьте размеры панели Effect Controls  насколько возможно. В панели Effect Controls откройте монтажный стол (щелкнув мышью Show/Hide Timeline View).
4. Добавьте ключевые кадры для свойства Rotation (Вращение) в четырех позициях: первый и последний кадр и еще два между ними. Чтобы это сделать, установите курсор текущей позиции редактирования на начало клипа, включите режим анимации эффекта свойства Rotation (используйте кнопку Toggle Animation), при этом ключевой кадр создается в начале клипа со значением параметра по умолчанию, равным нулю.
5. Затем, установив курсор текущей позиции редактирования в трех остальных точках поочередно, щелкните мышью на кнопке Add/Remove Keyframe в каждой заданной позиции. Панель Effect Controls на вашем экране должна быть похожа на изображенную на следующем рисунке.
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6. Посмотрите на числа на предыдущем рисунке.
100 и -100 - максимальное и минимальное значения по умолчанию параметров свойства Rotation. Эти параметры меняются в зависимости от изменения фактических параметров Rotation, как только вы меняете настройки для ключевых кадров;
1 и -1 - значения по умолчанию для относительной скорости. Так как никакие параметры вы не меняли, скорость в данном случае представляет собой прямую линию, а значение параметра равно нулю.
7. Измените значение параметра Rotation для второго, третьего и четвертого ключевых кадров:
Второй ключевой кадр. Введите количество оборотов, равное 2 для свойства Rotation (два полных оборота по часовой стрелке);
Третий ключевой кадр. Поверните влево колесико вращения для свойства Rotation, пока не отобразится значение -2x0.0°;
Четвертый ключевой кадр. Перетащите маркер графика значений до значения -1x0.0°.
После окончания настройки параметров ваши ключевые кадры и графики должны быть похожи на изображенные на следующем рисунке.
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8. Перетащите курсор текущей позиции редактирования через клип и понаблюдайте за изменением параметра Value (Значение), графиками скорости и числами слева от графиков (показанные на предыдущем рисунке):
Верхнее и нижнее числа параметра Value изменились на 2x0 и 
-2x0 (два полных вращения в обоих направлениях), чтобы показать фактические максимальные и минимальные значения параметра. Эти значения остаются неизменными при перемещении курсора текущей позиции редактирования;
На графике значений видны значения параметров в любой момент времени;
Верхнее и нижнее значения параметра Velocity (Скорость) в левой части графика отмечают граничные показатели скорости в градусах в секунду. Числа, показанные на предыдущем рисунке - 1x32 и 
-1x32 - означают 392° (360+32) по часовой стрелке и против часовой стрелки. Эти значения не обязательно равняются фактическим верхним и нижним показателям скорости, просто определяют текущий максимум и минимум скорости на оси Y графика X/Y;
График скорости показывает скорость между ключевыми кадрами. Внезапные снижения или скачки представляют внезапные изменения ускорения - толчки на языке физики. Точки на графике выше средней области графика скорости представляют положительные (по часовой стрелке) скорости, а точки ниже центральной линии представляют отрицательные (против часовой стрелки) скорости. Чем дальше точка или линия от центра, тем больше скорость.
9. Воспроизведите этот клип.
Стрелка будет вращаться по часовой стрелке два раза, быстрее вращаться против часовой стрелки четыре раза и более медленно вращаться по часовой стрелке один раз.
10. Щелкните правой кнопкой мыши на первом ключевом кадре и в появившемся контекстном меню выберите команду Ease Out (Легкое ускорение).
Произойдет следующее:
значок ключевого кадра становится похожим на песочные часы;
точка графика теперь представляет собой маркер, который можно перемещать инструментом Реn (Перо), а график содержит небольшую кривизну;
эти кривые показывают изменение скорости во времени - т.е. ускорение.
Воспроизведите этот фрагмент клипа. Эффект выглядит более реалистичным.
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Щелкните правой кнопкой мыши на следующих трех ключевых кадрах и установите способы интерполяции (в следующем порядке): Bezier (Безье), Auto Bezier (Авто-Безье) и Ease In (Легкое замедление). Ниже приводятся способы интерполяции ключевых кадров в программе Adobe Premier:
Linear (Линейный) - заданный по умолчанию режим. Одинаковая скорость движения между ключевыми кадрами;
Bezier (Безье) позволяет вам вручную корректировать форму графика по обе стороны ключевого кадра. Этот вид сглаживания учитывает внезапные изменения ускорения перед или после ключевым кадром;
Continuous Bezier (Непрерывный Безье) сглаживает изменение скорости при прохождении через ключевой кадр. В отличие от способа Bezier (Безье), если вы корректируете один маркер, то маркер с другой стороны ключевого кадра также движется некоторым образом, чтобы обеспечить гладкий переход через ключевой кадр;
Auto Bezier (Авто-Безье) сглаживает изменение скорости при прохождении через ключевой кадр, даже если вы меняете значение ключевого кадра. Если вы выбираете ручной способ корректировки маркеров, этот метод сглаживания изменяется до точки с режимом Continuous Bezier, сохраняя гладкий переход через ключевой кадр;
Hold (Закрепить) изменяет значение свойства без постепенного перехода (резкое изменение эффекта); после ключевого кадра, для которого применили интерполяцию Hold, график скорости представляет собой горизонтальную прямую линию;
Ease In (Легкое замедление) замедляет скорость изменения параметров перед ключевым кадром;
Ease Out (Легкое ускорение) постепенно ускоряет изменение значений после ключевого кадра.
11. Монтажный стол панели Effect Controls должен быть похож на рисунок, приведенный ниже (границы графиков значений и скорости могут отличаться в зависимости от размера панели Effect Controls).
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12. При добавлении кривых значения параметров изменяются по ходу действия эффекта так, что иногда могут превышать максимальное значение ключевого параметра или быть меньше самого низкого установленного вами значения ключевого параметра.
13. Воспроизведите весь клип и обратите внимание, как плавно воспроизводится эффект.
В результате простого добавления интерполяции ключевых кадров эффект Motion выглядит значительно реалистичнее.
Выделите второй ключевой кадр (песочные часы Безье). На кнопках Value Graph (График значений) и Velocity Graph (График скорости) этих ключевых кадров появляются маркеры инструмента Реn так же, как на двух смежных наборах кнопок. Изменение одних маркеров интерполяции ключевых кадров может изменить поведение близстоящих ключевых кадров.
14. Перетащите мышью маркер линии Velocity Graph (График скорости), выделенный на следующем рисунке, влево. Это создает крутую скоростную кривую, означая, что движение стрелки резко ускорится, затем быстро замедлится, но, тем не менее, совершит два оборота между первым и вторым ключевыми кадрами. Вы изменили скорость, не меняя значения.
[image: ]
15. Выделите третий ключевой кадр (круглый значок Auto Bezier).
Перетащите мышью маркер, выделенный на следующем рисунке, и обратите внимание, что круглый значок ключевого кадра немедленно переключается в песочные часы, поскольку ручная регулировка ключевого кадра Auto Bezier делает его ключевым кадром Continuous Bezier.
16. При перетаскивании левого маркера правые маркеры также передвигаются, чтобы сохранить кривую Value Graph гладкой на протяжении ключевого кадра.
17. Щелкните мышью на кнопке Toggle Automatic Range Rescaling (Включить/выключить автоматическое масштабирование) (выделенную на следующем рисунке), чтобы отпустить кривые.
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18. Измените положение одного или двух маркеров и обратите внимание, что кривые могут распространяться за пределы границ прямоугольников Value Graph и Velocity Graph.
Активируя возможность Automatic Range Rescaling (Автоматическое масштабирование), вы всегда заключаете пределы графиков внутри границ, предоставленных панелью Effect Controls. Вот почему значения слева поддерживают изменения, позволяющие вам узнать новые верхние и нижние пределы.
Если вы добавляете еще один ключевой кадр, к нему будет применена функция Keyframe Interpolation (Интерполяция ключевых кадров). Когда вы добавляете ключевые кадры впервые, вы можете откорректировать кривые Value Graph и Velocity Graph вручную. Выполнение любых таких корректировок изменит значок ключевого кадра на песочные часы Bezier Keyframe interpolation (Интерполяция ключевых кадров Безье).
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Эффект Motion (Движение) используется для позиционирования, вращения или масштабирования изображения в видеокадре. Все эти настройки можно производить прямо в панели Program, перетаскивая в другую позицию клип или перетаскивая/вращая метки клипа с целью изменить размер, форму или координаты изображения.
Для работы с метками клипа нужно:
выделить клип на панели Timeline;
щелкнуть мышью на пространстве в панели Program.
В результате изображение клипа на экране будет заключено в рамку ограничения с перекрестием в центре. Кроме того, эффект Motion на панели Effect Controls будет активизирован.
Для задания траектории движения клипа следует включить работу с ключевыми кадрами на панели Effect Controls для эффекта Motion. 

Создайте пустую последовательность, добавьте на нее клип. Перейдите в начало клипа, задайте его местоположение. Перейдите в середину клипа, измените его координаты. Выполните те же действия для точки окончания клипа.
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Обратить внимание на следующие моменты:
траектория - это кривая линия. Для создания движения программа Adobe Premiere автоматически использует кривые Безье;
маленькие точки описывают и кривую, и скорость. Чем ближе друг к другу расположены точки, тем ниже скорость движения, чем они дальше - тем скорость выше;
маленькие четырехконечные звездочки представляют ключевые кадры.
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Рассмотрим параметры эффекта Motion, позволяющие работать с ключевыми кадрами:
Position (Позиция) - позиция якорной точки клипа на экране (по умолчанию якорной точкой клипа является центр кадра);
Scale Height (Шкала высоты), при сброшенном флажке Universal Scale (Линейная шкала) - это относительный размер клипа.
Scale Width (Шкала ширины). Чтобы активизировать данный параметр, необходимо сбросить флажок Universal Scale (Линейная шкала). Этот параметр позволяет изменять ширину и высоту клипа независимо друг от друга;
Rotation (Вращение). Можно вводить значение вращения в градусах или в количестве поворотов. Например, 450° или 1x90. Положительное число означает поворот по часовой стрелке, а отрицательное - против часовой стрелки;
Anchor Point (Якорная точка) - центр вращения клипа. Можно задать вращение клипа вокруг любой точки на экране, включая угол клипа, а также любую точку за пределами клипа;
Anti-Flicker Filter (Фильтр мерцания) - данное свойство полезно для тех изображений, которые содержат мелкие детали. Например, узкие линии, резкие границы, параллельные линии (проблемы с муаровым эффектом) или вращение. Указанные свойства могут послужить причиной мерцания изображения во время движения. Установка по умолчанию (0.00) не создает размывания границ, а потому - не устраняет мерцание. Чтобы добавить эффект размывания границ и убрать мерцание, следует использовать значение 1.00.

Программа Adobe Premiere позволяет работать с пространственным и временным методами интерполяции ключевого кадра:
Spatial Interpolation (Пространственная интерполяция) относится к траектории движения, то есть определяет, в каком месте экрана появится клип.
Temporal Interpolation (Временная интерполяция) относится к изменениям в скорости движения.

Для изменения типа ключевого кадра пространственной интерполяции необходимо использовать контекстное меню метки ключевого кадра на панели Program.
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Изменение типа ключевого кадра пространственной интерполяции не влияет на временную, и наоборот.
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1) Перечислите способы добавления ключевого кадра.
2) Как сделать так, чтобы эффект начинался после начала воспроизведения клипа?
3) Опишите два способа изменить свойства в ключевых кадрах.
4)  Как применить интерполяцию ключевого кадра и корректировать параметры настройки?
5) Какой параметр эффекта Motion нужно использовать, чтобы позиционировать клип по центру, но чтобы кадр слегка выходил за правый край экрана?
6) Вы начинаете вращение со стандартными значениями параметра Rotation, затем перемещаете курсор текущей позиции редактирования и создаете ключевой кадр со значением 2х, а затем устанавливаете значение параметра вращения -2х для следующего ключевого кадра. Опишите, что произойдет в данном случае.
7) Нужно, чтобы в течение нескольких секунд на экране была полноэкранная версия клипа, а затем, чтобы клип удалялся по спирали. Как активизировать свойство вращения не с начала воспроизведения клипа?
8) Как выбрать тип пространственной интерполяции параметра Position эффекта Motion и как его изменить?
9) Один из способов применения одного и того же эффекта к нескольким клипам - это шаблон. Как создать и как применить шаблон?
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Целью данной лабораторной работы является создание видео фильма, посвященному художественным дисциплинам кафедры ИТГД РГРТУ. Исходные материалы (видео в формате HDTV 1080i 50) расположены в каталоге PROJECT 04. Проект содержит:
видео, в котором преподаватели  кафедры рассказывают о свих дисциплинах ("Рисунок" - М.К. Шелковенко, профессор кафедры ИТГД; "Живопись" - В.В. Янаки, доцент кафедры ИТГД; "Пластическая анатомния" - Р.А. Лысенина, профессор кафедры ИТГД);
дикторский текст;
видео заставки. 
Результатом выполнения работы должен являться видео фильм, созданный на основе сценария, расположенного в файле Сценарий.doc.
Этапы выполнения работы:
задать параметры будущего проекта (формат кадра, частота кадров и т.д.);
осуществить предварительную подготовку материала, выбрав отдельные клипы, из которых и будет осуществляться последующий монтаж. Кроме файлов, расположенных в каталоге PROJECT 04, можно использовать:
фрагменты видео по указанным дисциплинам из каталога PROJECT 03;
фрагменты видео из современных видеофильмов и анимационных фильмов, подходящие по контексту к начальным словам диктора о виртуальной реальности;
любые дополнительные, в том числе собственные, материалы;
произведите предварительную обработку звука в Adobe Audition;
проведите анализ всех звуковых файлов;
проведите по необходимости шумоподавление, частотную коррекцию и динамическую обработку;
проведите редактирование амплитуды: дикторский текст и звук, записанный на микрофон, должны иметь одинаковые уровни громкости;
выберите фоновую музыку для видео фильма;
создайте мультитрековый проект и осуществите в нем монтаж, сведение и мастеринг звука;
выполните экспорт мультитрекового проекта в виде стерео файла для дальнейшего осуществления видеомонтажа;
осуществить монтаж видео фильма, используя выбранные для фильма клипы;
разбейте видео ряд и дикторский текст видео и аудио вставками.
добавьте и настройте необходимые эффекты и переходы. Для настройки эффектов используйте: управление ключевыми кадрами, графики значений и скорости изменения параметров, ускорение/замедление скорости.
используйте видео заставки; примените к ним эффекты движения, вращения, масштабирования, используйте эффект «картинка в картинке»;
выполните экспорт видеофильма (выбор формата и кодека должен быть обоснован);
добавьте финальные титры, указав в них информацию о людях, участвовавших в создании фильма:
сценарий, дикторский текст: Царев Н.Н.;
оператор: Фролова Е.Н.;
видеоэффекты: Арбузов А.В.;
запись звука: Наумов Д.А.;
монтаж: собственные фамилия, и.о.;
указать в титрах авторство всех заимствованных материалов (видео и аудио).
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